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About Audacity

Audacity is a free, open-source audio editor and recorder that can be used on several operating systems
including Windows and MAC. The Audacity project was started nearly 20 years as part of a research
project at Carnegie Mellon University. This tool developed by Mazzoni and Dannenberg was initially
released as an open-source audio editor in May 2000.

Open-source software means that the source code is available for individuals to study, change, use, and
distribute. Currently, the tool is distributed the terms of the GNU General Public License (GPL) and
maintained by a team of global volunteers.

As a free software, you can install Audacity on any personal or work (with appropriate permissions)
device for personal, commercial, or educational use. For other terms and conditions regarding the
reselling and rebranding of Audacity, visit their site at https://www.audacityteam.org/about/license/.

Features
With Audacity’s many features, you will have a range of editing and recording capabilities such as:

e Recording live audio through a mic or mixer

e Managing audio files including MP3, WAV, and OGG VORBIS

e Using keyboard shortcuts to support accessibility to design features

e Editing audio files using familiar cut, crop, do/undo and paste functions
e Importing and combining audio files

e Exporting multiple files at once

Additional Resources
License and Copyright: https://www.audacityteam.org/about/citations-screenshots-and-permissions/

Voluntary Product Accessibility Template: https://www.audacityteam.org/about/voluntary-product-
accessibility-template-vpat/

Privacy Policy for Mailing Lists (Self-registered users): https://www.audacityteam.org/contact/privacy-

policy/

Audacity Tutorials: https://manual.audacityteam.org/man/tutorials.html

Audacity Basic Audio Editing Tutorial 2018 Video: https://youtu.be/ZWoycsTWLQk
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Download Audacity

Currently, Audacity is only available as a 32-bit application that can be used on a 32-bit and 64-bit
system. In order to use Audacity on your Windows, MAC, or GNU/Linux device, you must download the
software. You also have the option of building Audacity yourself utilizing the source code.

Safe Downloading & Access Links

Prior to downloading the software, visit Audacity’s safety when downloading page where you can access
their checksum list for insuring that the download file is correct:
https://www.audacityteam.org/download/online-safety-when-downloading/

Click the following links adjacent to your operating system to download the software. Please note that
GNU/Linux is source code for those advanced users desiring to build their Audacity, rather than simply
download the software.

Audacity for Windows https://www.audacityteam.org/download/windows/

Audacity for MAC OS X/macOS https://www.audacityteam.org/download/mac/

Audacity for GNU/Linux (source code) | https://www.audacityteam.org/download/mac/
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Installation Steps

The installation steps provided here have been captured in Windows, therefore the process of installing
the software in MAC may differ slightly. It is suggested that you close other applications prior to starting.

1. After clicking the
download link, you
will be taken to the
download page. If
you are new to
Audacity, it is
recommended that
you select the first

Recommended Downloads - Latest Version of Audacity

click the text link to start the download. Right-click and “Save as...~ will not work.

Audacity 2.2.2 I
. . . Audacity 2.2.2 installer (19.31 MB, includes help files)
installer link which =
has help files by ca19471e10660765dec12c980ebd3eeboh82826ea4f25hca90936f312b14caff

. e " » Audacity 2.2.2 zip file (11.42 MB) - smaller download (without help files), also useful if you cannot
clicking the file

g run the installer because of restricted permissions

name once. If you SHA256:
haVe I|m|ted Space 59ddfd98277791a3c48dd55150f1bf77e79c0330fd4fdca9e330c5dd144e4927

-

View Checksums

or do not need the
help files, select
the Zip File.

System Requirements

2. From the FossHub, bypass the Start Now button and scroll down just beneath the ad to select
the appropriate link for your download as indicated in the screenshot below. The first link is for
the system installer. Click the link for Audacity Windows [MAC OS] Installer.

Home Audio Editors Audacity

Audacity

sk dook (227 ) 0 from hitp://audgfityteam org

Anti-Malware

Audio Editors
Advertisement
Audio
> x
1. Click "Start Now”

START NOW 2. Click “Add” O My Templates

3. Open a New Tab Page

Download Audacity Windows Installer - 1 MB | version: 2.2 2 | SHA256 signature

on signature

Codec Packs on: 2.2 2 | SHA256 signature
on: 2.2.2 | SHA2S6 signature
Download Audacity Manual - 12 23 W | version 22 2 | SHA256 signature
Developer Tools Download Audacity LADSPA plugins for Mac - zip - 2 74 VB | version’ 0.4 15 | SHA256 signature
Download Audacity LADSPA plugins for Windows - installer - 1 44 B | version 0.4 15 | SHA256 signature
Download Audacity Mac OS X 2.1.1 - DMG (screen reader accessible) - MB | version: 2.1.1 | SHA256 signature
Download Audacity Mac OS X 2.1.1 - ZIP (screen reader accessible) - 16 50 1B | version 2 1 1 | SHA256 signature

Database Download Audacity Linux source - 7.83 VB | ver:

Ebook Apps

This software runs on: Windows, Linux, Mac, BSD Last updated: February 20, 2018
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3. Click Save File in the pop-up window.

You have chosen to open:

[5Z] audacity-win-2.2.2.exe

which is: Binary File (19.3 MB)

from: https://download.fosshub.com

Woeuld you like to save this file?

When you click the Save File button, the .exe file will download to your computer. Your browser
will notify you when the download is complete. For example, in the Firefox screenshot sample
below the download icon will turn blue when the download is complete.
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5. Onthe next screen, you will be greeted with a prompt to allow set-up by giving Audacity
permission to make changes to your machine. Select Yes. In the next pop-up, select your
preferred language from the dropdown menu and click OK.

Select Setup Language x
Select the language to use during the
installation:

English w

6. Click Next on the following prompt to continue to installation.

=) Setup - Audacity — X

Welcome to the Audacity Setup
Wizard

M Thig will install Audacity 2,2.2 on your computer.,

It is recommended that you dose all other applications before

Audacity. ===

Click Next to continue, or Cancel to exit Setup.

===

7. After reading through the licensing and software information, select Next to continue.

) Setup - Audacity — X
Information
Please read the following important information before continuing. Q

When you are ready to continue with Setup, dick Next.

P\udacit\ra is free, open source software for recording and editing ~
sounds. It is available for Mac 05 X, Microsoft Windows, GNU/Linux,
and other operating systems. Learn more about Audacity... Also check

our Wiki and Forum for more information

License: Audacity is free software. You may use it for any personal,
commercial or educational purpose, including installing it on as many
different computers as you wish. Audacity is licensed under the terms
of version 2 of the GNU General Public License (GPL| as published by the
Free Software Foundation. The full text of the license is also available
when running Audacity, via the Help menu > About Audacity... command
» GPL License tab.

< Back | Cancel
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. . . . € Setup - Audaci — %
8. Audacity will automatically direct the ° v

. . . . . Select Destination Location

|n$ta”at|0n flleS into the Program Flle Where should Audacity be installed? Q
directory. You can choose an alternate

|0Cati0 n |f desi red usi ng the Browse setup will install Audadity into the following folder,

fU n CtiO n. To continue, dick Next. If you would like to select a different folder, dick Browse.

Browse...

Click Next to proceed.

At least 52,2 MB of free disk space is required.

< Back | Cancel

4 Setup - Audacity - *
9. Confirm desktop shortcut in the next Select Additional Tasks Q
. Which additional tasks should be performed?
step. Make sure that if you do not want
Aud a C|ty insta I |ed to yo ur desktop that Select the additional tasks you would like Setup to perform while installing Audadity,

then dick Mext.

you deselect that option. Ackitond] shorteute:

Create a desktop shortout

[] reset Preferences

Click Next to continue.

< Back | Cancel

& Setup - Audacity — >
10. The next screen will show a summary of Ready to Install
Setup is now ready to begin installing Audadity on your computer. Q

your destination settings.

Click Install to continue with the installation, or dick Back if you want to review or
change any settings.

Destination location:
C:\Program Files (x86)\Audacity

. re . . Additional tasks:
If you are satisfied with these settings, Adeitonal shortauts:

. Create a desktop shortcut
click Install to move forward. If you are
not, use the Back buttons to adjust
locations as needed.

= Ba& Cance'
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11. After you select Install, read the copyright information and visit relevant links to support and
resources. Press Next to continue the installation.

- Setup - Audacity —
Information
Please read the following important information before continuing. Q

When you are ready to continue with Setup, didk Next.

budacity(R): free, open source, cross-platform audio software for ~
multi-track recording and editing: https: /fwww. audacityteam.orgf .

User suppport is prawded on .-'-\udaaty Forum:
+ffforum. it i

25.

Audadty is copyright (c) 1999-2018 by Audadty Team. This copyright
notice applies to all documents in the Audadity source code archive,
except as otherwise noted {mostly in the lib-src subdirectories).
"Audacity” is a registered trademark of Dominic Mazzoni,

- [ T e S ' [T .- -

12. The installation will last for a few moments. When all of the Audacity files have been installed,
you can click the Finish button to exit the set-up. The launch button has been selected by
default so that when you do select Finish, Audacity will open. Deselect this option if you wish to
work in the tool at a later time.

“ Setup - Audacity —

Completing the Audacity Setup
Wizard

M Setup has finished instaling Audadty on your computer, The

application may be launched by selecting the installed
shartcuts,

AUda Ci ty@ Click Finish to exit Setup.

Launch Audacity

<gacc I Fnsh ]
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Navigating the Audacity Interface

Now that you’ve installed Audacity, you will want to familiarize yourself with the interface. Please read
descriptions of the key components below.

€ Audacity G - O X
File Edit Select View Transport Tracks Generate Effect Analyze Help
° < /| & |- 57545148 45422 Cickto Start Montoring 1 181512 9 6 3 0
nHn = m I« > ] T T T T T T T o v v e v e
Sk o) [ 575451434542 3635 -33 30 -27 24 -21 181512 B 6 3 0
_ - = Z
Q, : 24) o XKD ] |~ @e]|QQR P et
GME ~ & | Line (Dell AC511 USB Sounc |2 (Stereo) Recor ) Speakers (Dell AC511 USBS |
¥ -1.0 CH 1.0 20 3.0 4.0 5.0 6.0 7.0 8.0 9.0

Start and End of Selection ~
44100 ~| |lom v [loonoomo0.000s~ [00n00mO00.000s~ [00R00mM00.000s

?Uject Rate (Hz) | Snap-To | Audio Position

pped.

1. Menu Bar: access to commands such as file upload, creating new audio, and processing audio.

2. Transport Toolbar: buttons for controlling playback, recording, and moving projects.

3. Mixer Toolbar: can be used to adjust the volume for recording and playback.

4. Tools Toolbar: enables you to manage tasks such as zooming, time-shifting, and adjusting volume.

5. Device Toolbar: select your device for recording and playback.

6. Track Display Area: the project window, acts as a visual display area for audio tracks.

7. Selection Toolbar: use to control project rate and manipulate time.

8. Status Bar: displays message about recording/playback, indicates where mouse is hovering, shows hints.
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Getting Started with Audacity

Audacity can be used to import and record audio files. This is a quick guide to the basic tasks of:

e |Importing and recording audio

e Selecting audio to edit

e Editing your audio

e Saving your Audacity project

e Exporting your audio to MP3 or other audio file

Prior to performing these tasks, it is helpful to have an understanding of the menu bar commands in
Audacity. The image below is the menu bar as it appears in Windows.

- Audacity
File Edit

Generate

Select  View Transport Tracks Effect Analyze Help

Command What it provides...

File Contains commands for creating, opening, importing, and exporting Audacity files
Edit Basic editing commands: Undo, Delete, Duplicate, Paste

Select Enables you to select specific parts of the audio track

View Allows you to zoom in on track details and view track history

Transport Commands include Play, Stop, Record, and Scrubbing

Tracks Commands are for creating and removing, mixing, muting, aligning, sorting tracks
Generate For audio creation using noise, silence, or tones-includes rhythm track, risset drum
Effect Commands to apply effects to audio such as fade, reverse, bass, and echo

Analyze Tools for finding out details in your audio including silence detection

Help Commands to access Audacity manuals, screenshots, and diagnostic resources
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Importing Audio

Import simply means adding new content to an Audacity File Edit Select View Transpo
project. Audacity can import and play a variety of audio formats Mew Ctrl+ M
including AIFF, AU, FLAC, MP2, MP3, OGG Vorbis and WAV in Open... Ctrl+0
Windows, as well as M4A and MOV files from Apple device :

Recent Files >

Cloze Ctrl+W
To edit files for a new project, you can either drag the files into 5ave Project Ctrl+5
the project window or click File in the menu bar and choose Save Project As..,
Open to select your audio file. Export 3

=== |mport >

If you want to add files to a currerﬁroject, click File and choose Chains >
Import and then select Audio type.

Page Setup...

Print...
Recording Audio Exit Ctrl+Q

It is advisable that when recording with Audacity that you close all other applications. This can help
minimize technical issues such as recording ticks. First, you will need to select your recording device.

Be mindful that bad audio can distract from the message that you are attempting to send. An external
mic with noise cancellation is strongly suggested in order to enhance the quality of your recording.

First, select your device using the Device Toolbar.

MME w \.!; Line (Dell AC5311 USBE Sount ~ 2 (Stereo) Recor ‘D Speakers (Dell AC311 USB S

1. Selectthe ¥ menu for options to select your built-in computer mic or another attached device
which you will use for recording. Next to the mic options is the Recording Channels feature.
Channel refers to the number of signals used by the microphone driver. If your device is mono,
Select 1 (Mono). If the device is stereo, select 2 (Stereo). Refer to your mic property settings for
more information if you are not sure which channel to select.

2. Next, use the playback ‘D menu to select your playback device. The playback device is not
separate from the selected recording device and the appropriate device should appear by
default. After selecting your device, you can monitor your voice level and adjust as needed. The
playback sound can be adjusted using the right-hand slider on the Mixer Toolbar. Adjust the

recording volume with the left Y slider.
\ oo K
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3. Press the Record button in the Transport Toolbar to start recording.

File Edit Select View Transport Tracks Generate

] [ | I« >

When you are done recording, press the | stop button.

Tip: Export the audio so that you have an original copy prior to editing. To do so, click File, then Export
and Export Audio and select to WAV or AIFF.

Selecting Audio to Edit

Using your mouse to select parts of the track to edit will facilitate smoother editing. I J-"
First, make sure that the Selection tool from the Tools Toolbar is still highlighted blue s
(by default). If not, click the I in the toolbar. Then, use your mouse to left click Q‘ H

anywhere inside the audience track to edit. A hand icon will appear, pointing to a

vertical selection line. By dragging this line, you can move the selection boundary and
pick a portion of the track. Release your mouse when done isolating your selection to start editing.

N

30 45 1:00 *:;15 1:30 1:45 2:00

You can also select the entire track by using the Select command from the Transport Toolbar. Choose
Select > All or the shortcut Ctrl + A.
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Editing Your Audio

File Edit Select View Transport Tr

Editing actions that are commonly used can be found in the L Ll
Edit menu. In addition to edits such as cutting and pasting you Redo Ctrl+¥
may want to add additional effects using the Effects menu. Cut Cirle X
To edit a file, select the region you want to edit by left-clicking Delete Ctrl+ K
in the track and then by dragging the shaded area. If you do not Copy ChrleC
select a portion of the audio, Audacity will select all of the e R
audio track displayed in the project window by default. aste o

Duplicate Ctrl+D

About common editing menu options
Undo-undoes the last editing operation you performed to your
project

Redo-redoes editing operations that were undone; if you
perform a new edit, you cannot redo operations that were

Remove Special

Clip Boundaries
Labels
Labeled Audio

undone
Metadata...

Cut-removes selected audio data and labels and copies them to

the clipboard Ctrl+P

Preferences...

Delete-removes selected audio and labels without copying
them to the clipboard

Copy-copies the audio data to the clipboard without removing it from project

Paste-pastes audio data which has been cut or copied to the clipboard; inserted at cursor point, or
replaces selection

Duplicate-creates a new track containing only the current selection as new clip

Choosing Effects

To apply effects, you will first need to left-click within the track to select the audio. Next, click the Effects
menu and choose an effect. Lastly, set the parameters for the effect and select the Start Playback or
Preview button to preview. When you are satisfied with the effect press OK to apply it to your audio.

Effect Analyze Help

Add / Remove Plug-ins... Amplify... Change Tempo — m] *
Repeat Last Effect Ctrl+R Auto Duck... Change Tempo without Changing Pitch
Audaci‘ty N Bass and TrEble"' Percent Change:
Change Pitch... ]
LADSPA ¥ Change Speed... .
Nyquist 5 Beats per minute
e TR ) I

Click Removal...

Compressor... Length (seconds)

Distortion... \ from 1632
iz [JUse i ity stretching (slow)

Equalization... Manage Breview

w (]

e
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Saving and Exporting Audacity Projects

Saving Your Audacity Project

To continue editing your audio file in Audacity with other tracks, you will need to save an Audacity
Project. Click the File button on the Transport tool and select Save Project. The file will save as an .aup
project file and a _data folder containing the actual audio.

This saves or updates the .aup file and _data folder. Saving a project lets you save unfinished work and
reopen it later in Audacity exactly as it was and with all your edits and recorded tracks still in place.
Please note that .aup files cannot be opened by other programs and must be kept together in the folder
as created by Audacity. Please do not rename or move files as you may not be able to reopen them in
Audacity for further edits.

. File | Edit Select View Transport Tracks Generate Effect Analyze Help
You can also select the Save Project As

. X X Mew Ctrl+N
option for saving an empty project or for Open.. _—
saving an existing project with a new Recent Files N
name. According to Audacity developers, . -
Save Project As is also the safe and Save Project Ctrl+S Export as MP3
recommended way to make a copy of a Save Project As. Export as WAV
project with a new name or in a different Sl d Export as 0GG
. . . . Export Audic... Ctrl+Shift+E
location which can serve either as a single Import > ? _
Export Selected Audio...
backup copy, or as one of several Chains > Export Labels..
incremental copies of the project. Page Setup.. Export Multiple... Ctrl+Shift+L
Print... Export MIDI...
Exit Ctrl+Q Save Compressed Copy of Project...

Exporting Your Audacity Project

To share your audio or to hear your audio in other applications, you will need to Export the files from
Audacity. Available formats in Audacity include WAV and Ogg Vorbis.

One of the most commonly shared formats is MP3. However, in order to export as MP3s, you will need
to have Lame MP# encoder installed on your device. In addition, for other formats including MP4, WMA,
and AMR, you will need FFmpeg library.

Access guide for installing these tools at:

https://manual.audacityteam.org/man/faq installation and plug ins.html#lame

To export a file, select File and then Export and choose among these options:

e Export as Audio (MP3, WAV)-choose the file format you want to export in the dropdown menu
e Export Selected Audio-to export only selected audio
e Export Multiple-to export multiple files at the same time
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